
AIM-Spice

User Guide



Contents

Chapter 1. Introduction ..................................................................................................... 1

1.1. Conventions Used in the Documentation................................................................ 2

1.1.1. General conventions ....................................................................................... 2

1.1.2. Mouse Conventions........................................................................................ 2

Chapter 2. Getting Started................................................................................................. 4

2.1. Hardware Requirements......................................................................................... 4

2.2. Software Requirements .......................................................................................... 4

2.3. Installing the AIM-Spice Simulator Package .......................................................... 4

2.4. Running AIM-Spice............................................................................................... 4

Chapter 3. Editing your Circuit Description....................................................................... 6

3.1. Typing and Formatting Text................................................................................... 6

3.1.1. Moving the Insertion Point ............................................................................. 6

3.1.2. Formatting Text ............................................................................................. 7

3.1.3. Scrolling......................................................................................................... 7

3.2. Editing Text........................................................................................................... 7

3.2.1. Selecting Text ................................................................................................ 7

3.2.2. Replacing Text ............................................................................................... 8

3.2.3. Deleting Text ................................................................................................. 8

3.2.4. Moving Text .................................................................................................. 8

3.2.5. Copying Text ................................................................................................. 8

3.2.6. Undoing an Edit ............................................................................................. 9

Chapter 4. Working with AIM-Spice Circuit Files ............................................................. 10

4.1. Opening Circuit Files ............................................................................................. 10

4.2. Creating a new Circuit File..................................................................................... 10

4.3. Opening an Existing Circuit File............................................................................. 10

4.4. Viewing a Circuit File in Another Directory ........................................................... 11

4.5. Opening Existing Standard Text Files..................................................................... 11

4.6. Importing Files....................................................................................................... 12

4.7. Saving a Circuit File............................................................................................... 12

4.7.1. Saving a New Circuit File ............................................................................... 12

i



4.7.2. Saving Changes .............................................................................................. 13

Chapter 5. Circuit description in AIM-Spice ...................................................................... 14

5.1. A Circuit Example ................................................................................................. 14

5.2. Names ................................................................................................................... 15

5.3. Nodes .................................................................................................................... 16

5.4. Values ................................................................................................................... 16

5.5. Circuit Elements or Devices ................................................................................... 16

5.5.1. Passive Devices .............................................................................................. 17

5.5.2. Semiconductor Devices .................................................................................. 17

5.5.3. Voltage and Current Sources.......................................................................... 17

5.5.3.1. Controlled Sources ................................................................................. 17

5.5.3.2. Independent Sources............................................................................... 18

5.5.4. Switches......................................................................................................... 18

5.6. Models .................................................................................................................. 18

5.7. Subcircuits............................................................................................................. 19

Chapter 6. Circuit Analysis with AIM-Spice ...................................................................... 20

6.1. Operating Point...................................................................................................... 21

6.2. DC Transfer Curve ................................................................................................ 21

6.3. AC Small Signal Analysis....................................................................................... 22

6.4. Transient Analysis.................................................................................................. 22

6.5. Pole-Zero Analysis................................................................................................. 23

6.6. Transfer Function Analysis..................................................................................... 23

6.7. Noise Analysis ....................................................................................................... 24

6.8. Small Signal Distortion Analysis (Not available yet) ............................................... 25

Chapter 7. Setting Initial Conditions.................................................................................. 26

7.1. .IC ......................................................................................................................... 26

7.2. .NODESET ........................................................................................................... 26

7.3. IC=........................................................................................................................ 26

Chapter 8. Options ............................................................................................................ 28

Chapter 9. Interactive Simulation Control.......................................................................... 30

9.1. DC Operating Point ............................................................................................... 30

9.2. Pole-Zero Analysis................................................................................................. 30

ii



9.3. Transfer Function Analysis..................................................................................... 30

9.4. Noise Analysis ....................................................................................................... 30

9.5. AC, DC Sweep, Transient, and Distortion Analysis ................................................ 33

9.5.1. Selection of Variables to Plot ......................................................................... 33

9.5.2. Selection of Variables to Save ........................................................................ 35

9.5.3. Formatting Axes and Labels ........................................................................... 36

9.5.4. Arranging Plot Windows ................................................................................ 37

9.5.5. Starting a Simulation ...................................................................................... 37

9.5.6. Stopping a Simulation, or Resetting the Plot Limits ........................................ 37

9.5.7. Saving Results after Completing a Simulation ................................................. 38

9.5.8. Exiting after Completing a Simulation............................................................. 39

9.6. Error Reporting ..................................................................................................... 39

iii



Chapter 1
Introduction

Automatic Integrated Circuit Modeling Spice (AIM-Spice) is based on the most recent

version of the popular circuit simulator SPICE1 developed at the University of California, at

Berkeley.

The AIM-Spice simulation package consists of two applications running under Microsoft

WindowsTM version 3.1 or later: AIM-Spice itself and a graphic postprocessor, called AIM-

Postprocessor. An overview of the simulator package is shown in Fig. 1.

Fig.  1.   Overview of the AIM-Spice simulator package.

AIM-Spice features:

• Runs under the Microsoft WindowsTM Graphical Environment which gives you a

simple and user friendly interface.

• Allows for Interactive Simulation Control. AIM-Spice displays simulation results in

progress by plotting the output during the run with the option to cancel a simulation

at any time.

• Incorporates advanced semiconductor device models in addition to those supported

by Berkeley.

AIM-Spice is based on Berkeley Spice version 3.E1. This is presently the most advanced

version from Berkeley. Some of the updated features of this software are listed below.

                                               

1At the moment of writing, version 3.E1
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• Analyses supported: DC, AC, Transient, Transfer Function, Pole-Zero, and Noise

Analysis.

• New models from Berkeley: BSIM, BSIM2, lossy transmission lines, and MOS level

6.

• Improved DC Operating Point Analysis with gmin and source stepping.

AIM-Spice is a full blown Microsoft WindowsTM application and takes full advantage of all

Microsoft WindowsTM extensions to DOS such as: a more user friendly interface, more

available memory beyond the 640 KB DOS limit, and multitasking that gives you the

possibilities to switch to other applications to do meaningful work while a lengthy simulation

runs in the background.

This manual gives a detailed step-by step description of how to use AIM-Spice. We refer to

the AIM-Spice Reference Manual to get a full documentation on input syntax, devices and

device models supported.

1.1. Conventions Used in the Documentation
Before you start using this user guide, it's important to understand the terms and notational

conventions used in the guide.

1.1.1. General conventions
• The word "choose" is used for carrying out a menu command or a command button

in a dialog box.

• The word "select" is used for selecting a specific dialog option.

• Commands you choose are given with the menu name preceding the command name.

For example, the phrase "Choose File Open" tells you to choose the Open command

from the File menu.

• The phrase "Choose OK" means that you either can click the OK button with the

mouse or press the ENTER key on the keyboard to carry out the action you want.

1.1.2. Mouse Conventions
AIM-Spice requires a mouse with two buttons. Most mouse operations are performed with

the left mouse button, but this can be changed with the Control Panel. The phrase "mouse

button" means the left mouse button while "right" is given explicit when we want you to use

the right mouse button.

• "Point" means to position the mouse cursor until the tip of the pointer rests on what

you want to point at.

• "Click" means to press a mouse button and immediately release it without moving the

mouse.
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• "Double Click" means to press and release the mouse button twice in rapid

succession.

• "Drag" means to press and hold the mouse button while you move the mouse.
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Chapter 2
Getting Started

2.1. Hardware Requirements
Minimum - IBM 286 or compatible with 2 MB RAM. Recommended - IBM 386 or

compatible with math co-processor and 6 MB RAM.

2.2. Software Requirements
AIM-Spice is a Microsoft WindowsTM application, and can only be loaded under Microsoft

WindowsTM-3.1. This means that Microsoft WindowsTM-3.1 or later must be installed and

running before you can load AIM-Spice.

2.3. Installing the AIM-Spice Simulator Package
In order to install AIM-Spice on you computer, you have to:

1) Load Microsoft WindowsTM if not already done.

2) Insert the installation diskette.

3) Choose File Run from Program Manager.

4) Type a:setup in the text box and then choose OK. If you are not installing from drive A,

use the letter of the appropriate drive.

2.4. Running AIM-Spice
Select the AIM-Spice program group. To run AIM-Spice double click the program icon. (If

you do not have a mouse, use the arrow keys to move the highlight to the program icon and

press Enter.)

The main AIM-Spice window appears together with an untitled document window. This

document window is a text editor much like Notepad. This is where you enter your circuit

description (see Fig. 2).
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Fig.  2.   Main AIM-Spice window.
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Chapter 3
Editing your Circuit Description

The circuit topology is described with a list of circuit elements, called the netlist. This

description is made in a text editor which is integrated into AIM-Spice. In this Chapter, we

take a closer look at the text editor. In the next Chapter, we discuss the rules that apply in

making a netlist.

When AIM-Spice is finished loading, the text editor will be active. This is made clear to you

by the blinking insertion point in the upper left corner of the window. You are ready to type in

a new circuit description. If you return to the editor after doing some work in another

window, the insertion point reappears at the location you left it.

3.1. Typing and Formatting Text
The insertion point moves to the right when you start typing. If your typing goes beyond the

right margin, the text automatically scrolls to the left so that the insertion point is always

visible.

3.1.1. Moving the Insertion Point
As already mentioned, the insertion point appears in the upper left corner of the window when

AIM-Spice is finished loading. You can move the insertion point anywhere you want to insert

or edit text by moving the mouse cursor to the point where you want to place the insertion

point and click the mouse button.

To move the insertion point with the keyboard, use the following keys or key combinations:

To move the insertion point: Press:

to the right in a line of text Right arrow key

to the left in a line of text Left arrow key

up in a body of text Up arrow key

down in a body of text Down arrow key

to the beginning of a line of text Home

to the end of a line of text End

to the beginning of the circuit description Ctrl+Home

to the end of the circuit description Ctrl+End
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3.1.2. Formatting Text
The keys in the table below gives you the necessary operations to type in the text exactly as

you want it.

To: Press:

insert a space Spacebar

delete a character to the left Backspace

delete a character to the right Del

end a line Enter

indent a line Tab

insert a tab stop Tab

To split a line, move the insertion point to the position where you want the break, and press

Enter.

To join two lines, move the insertion point to the beginning of the line you want to move, and

press Backspace. The editor joins the line with the line above.

3.1.3. Scrolling
If the circuit description is longer or wider that can be shown at one time, you can scroll

through the circuit description.

3.2. Editing Text
You edit text using commands from the Edit-menu. You can delete text, move or copy text to

new locations. If you change your mind after editing the text, you can use the Undo command

to cancel your last edit.

Transferring text to and from other applications can be done via the clipboard. When you

delete or copy text with the commands Cut or Copy, the text is placed in the Clipboard. The

Paste command copies text from the Clipboard to the editor.

3.2.1. Selecting Text
Before you use a command from the Edit-menu to edit text, you must first select the text you

want the command to operate on.

Selecting text with the keyboard:

1) Use the arrow keys to move the insertion point to the beginning of the text you want to

select.
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2) Press and hold the Shift-key while moving the insertion point to the end of the text you

want to select. Release the Shift-key.

To cancel the selection, press one of the arrow keys.

Selecting text with the mouse:

1) Move the mouse cursor to the beginning of the text you want to select.

2) Drag the cursor to the end of the text you want to select. Release the mouse button.

3) To cancel the selection, press the mouse button.

3.2.2. Replacing Text
When you have selected the text you want to change, you can immediately replace it by typing

new text. The selected text is deleted when you type the first new character.

Replacing text:

1) Select the text you want to replace.

2) Type the new text.

3.2.3. Deleting Text
1) Select the text you want to delete.

2) Choose Edit Delete.

To restore deleted text, choose Edit Undo immediately after deleting the text.

3.2.4. Moving Text
You can move text from one location in the editor by first copy the text to the Clipboard with

the Cut command, and then pasting it to its new location using the Paste command.

To move text:

1) Select the text you want to move.

2) Choose Edit Cut.

The text is placed in the Clipboard.

3) Move the insertion point to the new location.

4) Choose Edit Paste.

3.2.5. Copying Text
If you want to use a text more than once, you don't need to type it over each time. You can

copy the text to the Clipboard with Copy, and then you can paste the text in as many places as

you want by using the Paste command.
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To copy text:

1) Select the text you want to copy.

2) Choose Edit Copy.

The text is placed in the Clipboard.

3) Move the insertion point to the location where you want to place the text.

4) Choose Edit Paste.

3.2.6. Undoing an Edit
The Undo command can be used to cancel the last edit you made. For example, you may have

deleted text you wanted to keep, or you have copied text to a wrong location. If you choose

the Undo command immediately after you did the mistake, the text will be restored to the way

it was before you made the mistake.

To undo the last edit:

• Choose Edit Undo.
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Chapter 4
Working with AIM-Spice Circuit Files

An AIM-Spice circuit consists of three main parts: the circuit description which is placed in a

text editor in a document window (called the circuit window), analysis parameters and

options, and information about the last run on the circuit. This information is stored in a text

file with a special format and is called a circuit file. To work with circuit files, you use

commands from the File-menu. These commands are used to create, open, and save circuit

files in AIM-Spice format.

4.1. Opening Circuit Files
You can open new or existing circuit files in AIM-Spice, Theoretically, there is no limit to

how many circuit files you can have open at one time. A new circuit window is created for

every circuit file you open and the circuit description is placed in that window.

When you want to close a circuit window and you have made some changes to the circuit

description or to other circuit information since you opened the file, AIM-Spice will ask you if

you want to save the changes. Use the following information to determine your response:

To: Choose:

save changes Yes

discard changes No

continue working in the current file Cancel

4.2. Creating a new Circuit File
• Choose File New.

A new circuit window is opened.

4.3. Opening an Existing Circuit File
Only files saved in the AIM-Spice format can be opened directly (it is possible to open

standard text files. This is described in Section 5.5). The default extension for these files are

CIR. You open an existing AIM-Spice circuit file with the following procedure:

1) Choose File Open.

The dialog box in Fig. 3 is displayed.
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Fig.  3.   The File Open dialog box.

2) Select the name of the file you want to open from the list box to the left.

3) Choose OK.

When you use the mouse, you can open the file in one operation.

• Double-click the filename of the file you want to open.

4.4. Viewing a Circuit File in Another Directory
The list box with files only lists files with the extension CIR in the current drive and directory.

It is possible to list other files as well.

To list other files:

1) Select the drive, directory or the group of files you want in the list box named

Directories, or type this information in the text box at the top of the dialog box. For

example, you can type *.CKT to see a list of all files with that extension.

2) Choose OK.

The list box to the left lists the files in the drive, directory or group of files you specified.

4.5. Opening Existing Standard Text Files
It is possible to open standard text files. When you specify such a file in the File Open dialog

box and choose OK, a message box is displayed that warns you that the file you try to open is

not an AIM-Spice circuit file. You can choose to cancel the operation or to continue opening

the file.

A standard text file is displayed in the same way as circuit files, but you have lost the benefits

of the integrated environment. When you look at the menu commands now, you see that most

of them are dimmed. All the menu items in the Options menu are dimmed and only one
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command in the Analysis menu is available, the Run Standard Spice File command. This

command runs the first analysis control line listed in the standard text file.

4.6. Importing Files
Another way of loading standard text files is with the Import command in the File menu. This

command converts a standard text file to AIM-Spice circuit file format. .OPTIONS control

lines and analysis control lines are converted to the format used by AIM-Spice.

After converting the file, trace through the circuit description and check if some lines need

manual converting. If you try to simulate a circuit with illegal lines in the circuit description,

AIM-Spice will remove these lines.

4.7. Saving a Circuit File
When you create a file or you want to take a break, you can save the file and return to it later.

Two commands are available for saving a file: Save As and Save.

4.7.1. Saving a New Circuit File
Use Save As when you want to give a name to the new file. You can also use Save As when

you want to save an old file under a new name.

To save a new file:

1) Select the circuit window you want to save.

2) Choose File Save As.

AIM-Spice displays the dialog box in Fig. 4.

Fig.  4.   The Save As dialog box.

3) Type the name that you want to give to the file in the text box.
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If you don't give an extension, AIM-Spice will give it the extension CIR.

4) Choose OK.

AIM-Spice saves the file on your disk.

The circuit window will remain on the screen so that you can continue your work. The name

that you gave the circuit file now appears in the title bar of that window.

4.7.2. Saving Changes
You can use the Save command when you want to save changes to a circuit you currently are

working with.

To save changes:

• Choose File Save.

The file on your disk or diskette is replaced with the current version of the circuit.
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Chapter 5
Circuit description in AIM-Spice

Above we learned about how to work with the editor in AIM-Spice, and how to manage

circuit files. We are now ready to learn how to define our circuits. In this Chapter, we show

how to prepare a circuit description using a differential pair circuit as an example. The general

syntax is presented after the example.

5.1. A Circuit Example
Our sample circuit is shown in Fig. 5. Our first task is to give name to the nodes. A node name

can be any text string, except that the ground node which must have the name "0". The most

common way to name nodes is to give them numbers like we have done in the figure above.

The first line in the editor is taken as the title of the circuit, and the description of the circuit

starts at line 2. The elements in the circuit are also named, and the first letter of the name is

unique for that device type. For example, the names of resistors must start with the letter "R",

voltage sources with "V", bipolar transistors with "Q" etc. The subsequent letters in the name

can be any alphanumeric string. The circuit nodes to which the device is connected follows

immediately after the device name. The last field of the device description is the values of the

parameters that determine the electrical characteristics of the device. If you want to continue a

device description on a new line, place a '+' in column 1 of the new line.

VIN

Q3

Q1

RS2

1K

Q4

RC2

10K

RC1

10K

RBIAS

20K

8

7

6

21

4 5

3

9

VCC

12

RS1

1K

Q2

VEE

-12

Fig.  5.   Circuit example: differential pair.
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The complete circuit description for our example circuit is shown below together with

comments on some of the lines.

DIFFPAIR CKT - SIMPLE DIFFERENTIAL PAIR

VIN 1 0 SIN(0 0.1 5MEG 5NS) AC 1

VCC 8 0 12

VEE 9 0 -12

Q1 4 2 6 QNL

Q2 5 3 6 QNL

RS1 1 2 1K

RS2 3 0 1K

RC1 4 8 10K

RC2 5 8 10K

Q3 6 7 9 QNL

Q4 7 7 9 QNL

RBIAS 7 8 20K

.MODEL QNL NPN(BF=80 RB=100 CCS=2PF TF=0.3NS TR=6NS

+ CJE=3PF CJC=2PF VA=50)

In line 2 we have a voltage source with the name VIN. This source is specified with two

values. The first, SIN(0 0.1 5MEG 5NS) is used during a transient analysis. The voltage

source is specified with the predefined function SIN: VIN is sinusoidal with 0 volt offset, 0.1

volt amplitude and a frequency of 5MHz delayed 5ns. The second value is used during an ac

analysis. AC 1 means that the source will have an amplitude of 1 V during an ac analysis.

Line 5, 6, 11 and 12 describe bipolar transistors. The last field on these lines is QNL. This is a

device model specification. Bipolar transistors, like other semiconductor devices is described

in terms of specific models and associated set of model parameters. To find the parameter

values of the model QNL, we have to search for the line that starts with .MODEL, which in our

case is line 14. Once the model QNL is defined, it can be used on several devices. In our circuit

this model is used on all bipolar transistors.

We note the following:

• The first line (only) is the title line, and can contain any text.

• Comment lines are marked by a '*' in the first column, and can contain any text.

• Except the title line and subcircuit definitions, the ordering of the lines is arbitrary.

• AIM-Spice treats upper and lower case letters as they were equal.

• The number of blanks are not significant except in the title line, and comma, parentheses

and tabs are equivalent to blanks.

In the rest of this Chapter, we discuss the different elements making up a complete circuit, and

in the next Chapter, we focus on the set of commands available for simulating the circuit.

5.2. Names
Find the definition of the resistor RC1 in the circuit description above. It is line 7, starting with

RC1. The first field on that line is RC1, which is the name of the resistor. Names must start
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with a letter which signifies the type of the circuit device being considered. The rest of the

name can be any string of alphanumeric characters.

5.3. Nodes
In line 7, the two items after the name, 4 and 8 are the nodes to which the resistor RC1 is

connected. Node names are not limited to integers, but can be any alphanumeric text string.

There is one exception, the ground node must have the name 0. Nodes are not treated as

integers, but as text strings. Therefore 000 and 0 are different names.

5.4. Values
The last item on line 7 is 10K, which is the resistor value. Numerical values are written in

standard floating-point notation, with optional scale suffixes. Here are some examples of legal

values.

1.0 1. 1 0.5 .5 -1.0 1E6 1.6e-9

The scale suffixes follows the normal scientific notation shown below.

F = 10-15

P = 10-12

N = 10-9

U = 10-6

MIL = 25.4 · 10-6

M = 10-3

K = 10+3

MEG = 10+6

G = 10+9

T = 10+12

Units are also allowed, but are ignored by AIM-Spice. All characters that are not scale suffixes

can be used as units.

5.5. Circuit Elements or Devices
Every circuit element or device in the circuit is represented by a line not beginning with a

period. All this lines have the same format:

The name of the device, followed by

two or more nodes, followed by

a model name (not all devices have this), followed by

one or more parameters

All lines that don't start with a period, except for the title line, represent circuit elements or

devices.
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The first letter in a device name determines the device type. Names of resistors must start with

an "R", capacitors with a "C", diodes with a "D", bipolar transistors with a "Q", etc. The

device type specification determines the meaning of the information on the rest of the line:

how many nodes, if a model name is required, and which parameters are to be specified at the

end of the line.

Some of the devices allow or require a model name. A model gives you the possibility to

define model parameters once, and then use that set of parameters for as many devices as you

want. For example, all the transistors in the circuit above have the same beta, (β=80). All

refers to the same model, QNL which defines β in terms of BF=80.

The ordering of the device lines is not significant. How they are connected is determined by

the nodes. All device terminals with the same node name are connected.

The rest of this Section presents an overview of the device types available in AIM-Spice. A

complete description of the devices is found in the AIM-Spice Reference Manual.

5.5.1. Passive Devices
The passive devices available in AIM-Spice are: resistors, inductors, capacitors, transformers,

and transmission lines. They are all linear.

Resistors and capacitors can have model names, but is not required.

5.5.2. Semiconductor Devices
The semiconductor devices available in AIM-Spice are: semiconductor resistors,

semiconductor capacitors, RC transmission lines, p-n diodes, Schottky diodes, heterostructure

diodes, silicon Bipolar Junction Transistors (BJTs), Heterostructure Bipolar Transistors

(HBTs), Junction Field Effect Transistors (JFETSs), Metal Oxide Semiconductor Field Effect

Transistors (MOSFETs), compound semiconductor MEtal Semiconductor Field Effect

Transistors (MESFETs), Heterostructure Field Effect Transistors (HFETs), amorphous silicon

Thin Film Transistors (a-Si TFTs), and poly-silicon Thin Film Transistors (poly-Si TFTs). All

these devices require models. Additional information, such as device geometry, can be

specified.

5.5.3. Voltage and Current Sources
These devices are the only sources generating power. There are two types of sources:

controlled and independent.

5.5.3.1. Controlled Sources
All combinations of controlled sources are available in AIM-Spice: current controlled voltage

source, current controlled current source, voltage controlled voltage source, and voltage

controlled current source. They implement the following functions:
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v = h · i i = f · i v = e · v i = g · v

where the constants e, g, h and f, represents voltage gain, transconductance, current gain and

transresistance, respectively.

5.5.3.2. Independent Sources
Independent sources can have different values for different types of analysis. One value can be

specified for a Transient Analysis, another for an AC Analysis and so on. A value for a DC

Analysis must be prefixed by the keyword DC, the keyword for an AC Analysis is AC. For a

Transient Analysis use one of the following keywords: EXP, PULSE, PWL, SFFM, or SIN.

The voltage sources VIN, VCC and VEE are used in the above circuit example. From the

netlist, we infer that VCC and VEE have only dc values. The keyword DC can be omitted if a

source only acts in a dc mode. In our case VIN does not have a specified dc value, and it will

be set to 0 V during a DC Analysis. On the other hand, this source is specified for both an AC

Analysis (amplitude 1 V and phase 0 degrees) and for a Transient Analysis (sinusoidal with 0

volt offset, 0.1 volt amplitude and a frequency of 5MHz delayed 5ns). VCC and VEE will be

assigned a value of 0 V during an AC Analysis and with their specified dc values during a

Transient Analysis.

The following rules apply when specifying independent sources:

• Power supplies, such as VCC and VEE, can be written without the keyword DC.

• The inputs to the circuit, such as VIN, contain, for example, input waveforms and

clocks. AC values are given for computing frequency response.

• For a voltage source without specified values for a given analysis, the values will be set

to zero such that it will not influence the response of the circuit. However, the current

through such a source can be monitored, hence, allowing the source to be used as a

current meter.

5.5.4. Switches
Switches make it possible to change circuit connections during an analysis. They can be either

voltage or current controlled. Switches requires models. SW for voltage controlled switch and

CSW for current controlled switch.

5.6. Models
Many of the device types use models to specify different parameters describing the device.

The .MODEL statement has the following form:

.MODEL NAME TYPE (PARAMETER=VALUE PARAMETER=VALUE ....)

The model statement in the sample circuit is common for all the transistors in the circuit.

The AIM-Spice Reference Manual provides a complete list of all models used by AIM-Spice.

Each model has its own set of parameters. Since default values are assigned to all parameters,
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the specification of one or more parameter values can be omitted2. For example, if only default

values are used for a BJT, the model description becomes:

.MODEL QNL NPN

5.7. Subcircuits
When a circuit contains many identical blocks or subcircuits, it is convenient to be able to

write a block once and then reference it when needed. You can define a subcircuit as a "super"

device and reference it many times without retyping the block. Logical elements, for example,

are prime candidates for such subcircuits.

A subcircuit is defined in terms of a block of lines that start with the line .SUBCKT, and ends

with the line .ENDS. Between these lines there are one or more devices, models, call to other

subcircuits, and even new subcircuit definitions. When a subcircuit is defined, it can be

referenced as a device with a name that starts with the letter X.

Nodes can be defined as terminals for a subcircuit, making it possible to connect the subcircuit

to the rest of the circuit. Node names used in subcircuit definitions are local names, and they

will not conflict with global node names in the main circuit.

Above, we have seen how to describe circuits in terms of a netlist in AIM-Spice, and we are

now ready to perform the circuit analysis.

                                               

2This is not true for the BSIM models. For these models you have to give explicit values for all model

parameters.
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Chapter 6
Circuit Analysis with AIM-Spice

There are 8 different analysis types in AIM-Spice:

1) Operating Point analysis.

2) DC transfer curve analysis. A voltage or current source is swept over a user defined

interval.

3) AC small signal analysis. The frequency response of a circuit is calculated.

4) Transient analysis. The time domain response of a circuit is calculated.

5) Pole-Zero analysis. Locates poles and zeros in the small signal transfer function.

6) Transfer Function Analysis. Calculates the DC small signal transfer function, input

resistance and output resistance.

7) Noise Analysis. Simulates the device generated noise in the circuit.

8) Distortion Analysis. Calculates steady-state harmonic and intermodulation products for

small signal input magnitudes (Not implemented yet).

All analyses are available as commands from the Analysis menu. All analysis commands,

except for the DC Operating Point Analysis, require additional control parameters to be

specified. However, before choosing one of the commands in the Analysis menu, you should

decide which circuit to analyze and make the corresponding circuit window the active

window.

When you choose one of the commands from the Analysis menu, a dialog box appears. You

specify the control parameters in the dialog box before you start the simulation. All dialog

boxes have one command button labeled Run. You choose this button to initiate a simulation.

The dialog box for the Transient Analysis is shown in Fig. 6.

Fig.  6.   Dialog box for the Transient Analysis.

AIM-Spice User Guide 20



The dialog boxes contains three command buttons: Cancel, Save, and Run. When you have

completed the parameter fields, you can choose between these command buttons. If you

choose Cancel, the parameters you entered will be discarded. If you choose Save, the

parameters will be stored together with the rest of the circuit information. Run performs the

same command as Save and, in addition, initiates the analysis.

We will now discuss the control parameters for the different types of analyses available in

AIM-Spice.

6.1. Operating Point
This analysis calculates the dc operating point. No control parameters are required.

6.2. DC Transfer Curve

Fig.  7.   Dialog box for the DC Transfer Analysis.

In this analysis, one or two source(s) (voltage or current source) are swept over a user defined

interval. The dc operating point of the circuit is calculated for each value of the source(s). The

DC Transfer Curve Analysis is useful, for example, for finding the logic swing of logic gates,

I-V characteristics of a transistor, etc.

The first parameter in a dc analysis is the sweep variable(s). To specify a sweep source, open

the drop down list box next to the source name field to see a list of all sources in the circuit

and select one of them, or type a source name directly in the edit box. If you specify two

sources, the first one will be in the inner loop, i.e., it varies faster than the other. The other

parameters are the start, end and increment values for the source.

For example, if we want to find the I-V characteristics of a MOSFET, we can use the

parameter values shown in the dialog box in Fig. 7. The drain-source voltage source, vds, is in

the inner loop and sweeps from 0 to 5 V every time the gate-source voltage, vgs, changes

value (the start, stop and increment values of vgs are specified by selecting the 2. Source

button).
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6.3. AC Small Signal Analysis

Fig.  8.   Dialog box for the AC Small Signal Analysis.

This analysis calculates the frequency response of the circuit by linearizing the circuit

equations around the operating point.

The dialog box for the AC Small Signal Analysis is shown in Fig. 8. The first parameter

determines the number of frequencies at which the analysis is performed. The option buttons

in the dialog box determines the distribution of frequencies. If you choose LIN, the number

you specify will be the total number of frequencies. If you choose OCT, the value corresponds

to the number of frequencies per octave, and if you choose DEC, the value gives the number

of frequencies per decade.

The values in the dialog box specifies that the analysis starts at 1 Hz and ends at 10GHz, and

that the response is calculated at 200 frequencies distributed linearly in the interval.

6.4. Transient Analysis

Fig.  9.   Dialog box for the Transient Analysis.

The time domain response of the circuit is calculated from t = 0 to a user defined upper time

limit. The dialog box in Fig. 9 specifies a Transient Analysis which ends at 200ns with a

suggested stepsize of 2ns.
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This analysis have two optional parameters. The first one specifies that the generation of

output starts at a value different from zero. The second optional parameters sets an upper limit

on the timesteps used by AIM-Spice. If you specify a value for Maximum stepsize, you also

have to specify a value for Display start time.

Just as for the AC Small Signal Analysis, source values are taken from the device lines in the

circuit description. In our example circuit the voltage source VIN is specified with a sinusoidal

value during a Transient Analysis.

6.5. Pole-Zero Analysis

Fig.  10.   Dialog box for the Pole-Zero Analysis.

AIM-Spice is able to locate poles and zeros in a small signal ac transfer function. First the dc

operating point is calculated, and then the circuit is linearized around the operating point. The

resulting circuit is used to locate poles and zeros.

In the dialog box (see Fig. 10), you specify which type of transfer function you want, if you

want to locate both poles and zeros or only one kind, and nodes defining the input and output

of the circuit.

6.6. Transfer Function Analysis

Fig.  11.   Dialog box for the Transfer Function Analysis.
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This analysis computes the dc small signal value of the transfer function, the input resistance,

and the output resistance. In the example in the dialog box shown in Fig. 11, AIM-Spice

would compute the ratio V(8)/vin, the small signal resistance at vin, and the small signal

output resistance measured across the nodes 8 and 0.

6.7. Noise Analysis

Fig.  12.   Dialog box for the Noise Analysis.

The noise analysis portion of AIM-Spice computes device-generated noise for the given

circuit. When provided with an input source and an output port, the analysis calculates the

noise contributions of each device (and each noise generator within the device) to the output

port voltage. It also calculates the input noise to the circuit, equivalent to the output noise

referred to the specific input source. This is done for every frequency point in a specified

range. The calculated value of the noise corresponds to the spectral density of the circuit

variable viewed as a stationary gaussian process. After calculating the spectral densities, noise

analysis integrates these values over the specified frequency range to arrive at the total noise

voltage/current (over this frequency range). This calculated value corresponds to the variance

of the circuit variable viewed as a stationary gaussian process.

The format of the parameter "Output Noise Variable" is V(OUTPUT<,REF>), where

OUTPUT is the node at which the total output noise is sought. The parameter "Input Source"

is an independent source to which input noise is referred. The next three parameters are

frequency information identical to the AC Analysis. The last parameter is an optional integer;

if specified, the noise contribution of each noise generator is provided every "Points per

Summary" frequency point.
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6.8. Small Signal Distortion Analysis (Not available yet)

Fig.  13.   Dialog box for the Distortion Analysis.

The distortion analysis part of AIM-Spice calculates steady-state harmonic and

intermodulation products for small signal input magnitudes. If signals of a single frequency is

given as the input to the circuit, the values of the second and third harmonics are computed. If

there exists input signals of two frequencies, the analysis finds out the values of the circuit

variables at the sum and difference of the input

The first three parameters are identical to the AC Small Signal Analysis parameters. The last

parameter "F2 over F1" is an optional parameter. If you not specify "F2 over F1", the

distortion analysis performs a harmonic analysis, otherwise it performs a spectral analysis.

Refer to the AIM-Spice Reference Manual for a complete description of the distortion

analysis.
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Chapter 7
Setting Initial Conditions

Initial conditions means currents and/or voltages specified to help locating the bias point of a

circuit, or forcing the bias point to satisfy one or more conditions. One reason for giving AIM-

Spice initial conditions is to select one out of two or more stable states, for example, in

bistable circuits such as flip-flops.

There are three different ways of specifying initial conditions: the .IC statement, the

.NODESET statement, and the IC= specification on individual device lines. All these

statements are specified in the editor together with the netlist.

7.1. .IC
This control statement is used to specify initial values for a Transient Analysis. There are two

ways that this statement is interpreted, depending whether UIC (Use Initial Conditions) option

is selected or not (see the dialog box for Transient Analysis in Fig. 9). If UIC is selected, the

node voltages in the .IC statement will be used to compute initial values for capacitors,

diodes and transistors. This is equivalent to specify IC= for each device, but is much more

convenient. IC= can still be specified and will override the .IC values. However, AIM-Spice

will not perform any operating point analysis when this statement is used and, hence, the

statement should be used with care.

AIM-Spice will perform an operating point analysis before the Transient Analysis if UIC is not

specified. Then the .IC statement has no effect.

7.2. .NODESET
This control statement helps AIM-Spice locating the dc operating point. Specified node

voltages are used as a first guess for the dc operating point. This statement can be useful with

bistable circuits. In general, it is not needed.

.NODESET is active during all bias point calculations, not only with a Transient Analysis.

.IC have higher priority than .NODESET for a Transient Analysis.

7.3. IC=
Using this statement, capacitors, inductors, transmission lines, diodes and transistors can be

given initial values specified on the device line. The UIC option must be active in the Transient

Analysis dialog box in order to use these initial values. AIM-Spice will skip the calculation of
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the bias point and go directly to the Transient Analysis when the UIC option is active. All

devices which have not been assigned an IC= value are assumed to have a zero initial value.
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Chapter 8
Options

A set of options that control different aspects of a simulation is available. These are divided

between the following four logical groups corresponding to the dialog boxes shown in Figs.

14 to 17.

• General

• Analysis specific

• Device specific

• Numeric specific

Every circuit has its own set of options, and before you reset any of them, decide which circuit

you want to work with, and make the corresponding circuit window the active window.

To reset one of the options you choose commands from the Options menu. All options in a

group are listed in a dialog box together with their default values. You are free to change one

or more of the options. If you want to discard changes, choose the Cancel command button.

Fig.  14.   Dialog box for General Simulation Options.
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Fig.  15.   Dialog box for Analysis Specific Options.

Fig.  16.   Dialog box for Device Specific Options.

Fig.  17.   Dialog box for Numerical Specific Options.
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Chapter 9
Interactive Simulation Control

During a simulation, different commands can be executed depending on the type of analysis

being performed. DC Operating Point, Pole-Zero, and Transfer Function Analysis produce so

called one-vector-plots, i.e. they produce only one data point. Therefore these analysis are

executed immediately after you choose the Run command in the dialog boxes, and the results

are presented after the simulation is completed. The results are presented in a table for DC

Operating Point and Transfer Function Analysis, and in a graph for Pole-Zero Analysis. The

other analysis types produce output during the simulation and you have to select which

variables to monitor before you can start the simulation. The following sections explain the

different procedures for the different analyses.

9.1. DC Operating Point
As mentioned above, this analysis produce a so-called one-vector plot. The results are

presented in a table as soon as the simulation is completed. An example of such a presentation

is shown in Fig. 18.

9.2. Pole-Zero Analysis
Like the Operating Point Analysis, the Pole-Zero Analysis produces a one-vector plot. But

unlike the Operating Point Analysis, this analysis presents its results in a graph. An example is

shown in Fig. 19.

9.3. Transfer Function Analysis
This analysis also produces a one-vector plot, and the results are presented in a table as shown

in Fig. 20.

9.4. Noise Analysis
The noise analysis is special in the way that it produce more than one plot. It produces both

one-vector plots, and multi-vector plots. We have chosen to use the same interface as for the

analysis types listed above. The results are presented after the simulation is completed and

only one-vector plots are displayed. To display the other plots, use AIM-Postprocessor.
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Fig.  18.   Example of a presentation of DC Operating Point results.

Fig.  19.   Example of a presentation of results from a Pole-Zero Analysis.
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Fig.  20.   Example of a presentation of results from a Transfer Function Analysis.

Fig.  21.   AIM-Spice main window in analysis mode.
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9.5. AC, DC Sweep, Transient, and Distortion Analysis
AIM-Spice changes mode when you select the Run command from one of the analysis dialog

boxes. The menus listed in the menu bar will change and the status bar will give you

information about what happens at any time (see Fig. 21).

When AIM-Spice changes to analysis mode, the circuit description together with options and

analysis parameters are loaded into the AIM-Spice kernel. While reading the circuit into the

kernel, the status bar will show the text "Parsing circuit, Please wait". After the input and

error checking operation is done, the status bar shows which analysis is selected.

The simulation can only begin after you have specified which circuit variables to plot and the

plot limits. All commands needed to do the preliminary work before starting a simulation, are

located in the Control menu. This menu is shown in Fig. 22.

Fig.  22.   The Control menu.

9.5.1. Selection of Variables to Plot
In AIM-Spice you can open as many plot windows as you want. A plot window contains one

or more circuit variables that will be plotted graphically during a simulation. To open a new

plot window, choose Select Variables to Plot from the Control menu. This command displays

the dialog box shown in Fig. 23.

Fig.  23.   The Select Variables to Plot dialog box.
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This dialog box is divided into two main areas. To the left is a list of all the variables in the

circuit. The first element in this list is always the independent variable. The dialog box in Fig.

23 corresponds to an AC Analysis of our example circuit. In an AC Analysis, frequency is the

independent variable. The node voltages in the circuit are listed after the independent variable.

You can plot several variables in the same window by selecting more than one variable from

the list

The area below the variable list is active only for AC Analysis, in which case you can choose

either to plot the amplitude value or the phase value. If you choose to plot the amplitude, you

can select a dB-scale. This area is dimmed if other types of analysis is selected.

Select the variables you want to plot, and then choose the button labeled Y Axis Format to set

the vertical axis format. This command displays the dialog box shown in Fig. 24.

Fig.  24.   The Y Axis Format dialog box

As you can see from Fig. 24, AIM-Spice supports default values for the vertical axis. You

most likely will override some of these values, especially the axis limits.

Tip: Specify large intervals for the axis limits as a first guess. As the simulation progresses,

the plot traces will appear on the screen, and you can reset the limits manually or by the Auto

Scale command in the Format menu. This command automatically adjusts the vertical axis

limits to fit the simulation results.

Complete the Y Axis Format dialog box and choose OK to return back to the Select Variables

To Plot dialog box. Choose OK again and a new plot window is opened.

The title bar of the new window indicates which variables will be plotted in that window. To

open more plot windows, choose Select Variables to Plot again.

It is not possible to use the command Select Variables to Plot to add more variables when the

simulation is running, or after the simulation is completed. As soon as you start the simulation,

this command is disabled. To study your simulation results more carefully after the simulation

is completed, save the results to a file and use AIM-Postprocessor. We have chosen this

approach because we wanted the graphical operations in the simulator to be as fast as possible

and relax on the functionality requirements. This is the reason why the graphics capabilities in

the simulator may seem somewhat primitive.
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In Fig. 25. we have opened two plot windows.

Fig.  25.   Main window with two plot windows.

9.5.2. Selection of Variables to Save
The command Select Variables to Save is handy when you are simulating huge circuits

containing hundreds of nodes. Default is to save every circuit variable for the entire simulation

and in some cases this produces enormous amount of data. However, this command lets you

specify to AIM-Spice which variables you are interested in and want to save. Specifying a

small amount of variables to save reduces both the simulation time and the size of the output

file if you decide to save the results to a file for further processing by AIM-Postprocessor.

The command displays the dialog box in Fig. 26 containing a list of all circuit variables

together with two useful command buttons labeled Select All and Clear All..

Here you have the option of going through the list and select the variables you wish to save.

To select all variables in the list, choose the command button labeled Select All. To deselect

all variables in the list, choose the command button labeled Clear All. Note that the

independent variable (always the first variable in the list) is always saved, regardless of if you

select it or not.
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Fig.  26.   The Select Variables to Save dialog box.

9.5.3. Formatting Axes and Labels
When AIM-Spice creates a new graph window, it uses default axis and label formats. To

change the format use commands from the Format menu. You can use these commands as

long as you are in analysis mode. To format, for example, the x-axis of a graph first activate

the corresponding plot window and then choose the X-Axis command. If you have a mouse,

you may also double click the x-axis to change it's format. You can change the following

properties of an axis:

• Axis Type (linear or logarithmic).

• Base (when you select logarithmic axis, you have to choose which base number to

use, 8 or 10).

• Minimum value

• Maximum value

• Increment value (distance between axis labels).

• Minor tics (number of tic marks between labels).

• Grid lines (you specify line styles for grid lines drawn on major and minor tic marks

and if to turn grid on or off).

To format a label use commands from the Format menu, or double click a label. For labels you

can change the following properties:

• Notation (select between three numeric formats to use in the label, AIM-Spice scale

factors, decimal or scientific).

• Number of digits used in the numeric format.
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9.5.4. Arranging Plot Windows
Commands for arranging the plot windows are located in the Window menu. When you

choose Cascade, the windows will be placed in a stack. To place a given window at the top of

the stack, choose the title of that window from the Window menu. Choose Tile to arrange all

the windows side by side.

The plot windows can also be moved and resized with the mouse or with commands from the

system menu.

9.5.5. Starting a Simulation
To start a simulation choose the command Start Simulation from the Control menu. This

command is dimmed until limits are specified for all plots. Once the simulation is launched,

AIM-Spice plots the selected variables in the plot windows as soon as they are available from

the simulator. Fig. 27 shows a snapshot of typical simulation plots for a simulation in progress.

9.5.6. Stopping a Simulation, or Resetting the Plot Limits
If you realize that the limits you specified are unsuitable, you can open the Control menu any

time during the simulation and reset the limits. With a simulation in progress, the Control

menu is slightly altered from the one shown above.

First of all, the command Start Simulation is replaced with Stop Simulation. Second, all other

commands are dimmed. Hence, during a simulation you have only one command available

from the Control menu namely Stop Simulation. However, there is another way to reset

analysis limits. In the View menu there is the command Zoom. To make the Zoom command

active, choose the command once. A check mark appears next to the command name. Now

you can use the mouse to reset limits. Place the mouse cursor in the upper left corner of the

new viewing rectangle. Use the right mouse button, and drag the mouse cursor to the lower

right corner of the new viewing rectangle. Release the mouse button and AIM-Spice will

redraw your plot with the new viewing rectangle. When you choose the Zoom command once

more you deactivate the command, and the graph is re drawn with the original axis limits.
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Fig.  27.   Plots from a Transient Analysis in progress.

9.5.7. Saving Results after Completing a Simulation
AIM-Spice indicates that a simulation is finished by displaying "Simulation Done" in the status

bar. When a simulation is over, you can tell AIM-Spice to save the results in a file, by

choosing the Save Plots command from the File menu. This command displays the dialog box

shown in Fig. 28. This dialog box displays a list of accumulated plots since last time you saved

plots. If you want to save all plots in the list, choose the command Save All Plots. If you want

to save only a selection of the listed plots, select the plots you want to save, and choose Save

Selected Plots. If you are not interested in any of the plots, choose Destroy All Plots. When

one of the commands Save All Plots or Save Selected Plots are chosen, a Save As dialog box

is displayed. Complete the entries in the dialog box, and choose OK.
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Fig.  28.   The Save Plots dialog box.

Hint! If you want to compare results from different simulations in the postprocessor, run all

the simulations before you save the results. In that way one output file contains results from all

simulations. When you load this output file in the postprocessor, you are able to plot variables

from different simulations in the same graph.

9.5.8. Exiting after Completing a Simulation
To leave the analysis mode, select Exit Analysis Mode from the Control menu. The menu bar

changes back to the original menu and the circuit descriptions appears in the main window

again. To exit from AIM-Spice, choose File Exit.

9.6. Error Reporting
Error messages are written to an error file as soon as they are detected. When an error occurs,

AIM-Spice interrupts the simulation and displays the message box shown in Fig. 29.

Fig.  29.   Message box for error reporting.

If you choose the button labeled Yes, AIM-Spice displays the contents in the error file in a

pop up window (see Fig. 30).
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Fig.  30.   Popup window with error information.

This popup window exists as long as you want, and you close it in the same way you close the

main application window. The error window stays at the top of all windows belonging to

AIM-Spice.

To correct an error, you can quit the analysis mode and go back to the circuit window and

make the necessary changes to the circuit with the error window visible all the time. The error

window automatically closes when you start another run.
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